This version of the software has been retired.
This version of the software has been retired.

NOTICE
This document and the Sage 300 Construction and Real Estate Software MyAssistant software may be used only in accordance with the accompanying Innovative Software Design End User License Agreement. You may not use, copy, modify, or transfer the Sage 300 Construction and Real Estate Software MyAssistant software or this documentation except as expressly provided in the license agreement.

© 2015 Innovative Software Design. All rights reserved.
# Table of Contents

Conventions Used in this Document ........................................................................................................ 5  
Support and Training ............................................................................................................................... 7  
Telephone Support ................................................................................................................................. 7  
Sage Customer Portal ............................................................................................................................... 7  
Training ..................................................................................................................................................... 7  
Sage University ......................................................................................................................................... 7  
MyAssistant YouTube Channel ................................................................................................................ 7  
Local Business Partner ........................................................................................................................................ 8  
Before You Begin.................................................................................................................................................. 8  

**Chapter 1 – Back Up the MyAssistant Database** ................................................................................. 9  
**Chapter 2 – Upgrading the MyAssistant Server** ..................................................................................... 11  
Step 1 – MyAssistant Server Upgrade .................................................................................................. 12  
Step 2 – MyAssistant License Agreement ............................................................................................. 13  
Step 4 – MyAssistant Server Prerequisites (Optional) ......................................................................... 14  
Step 4 – MyAssistant Software ............................................................................................................... 15  
Step 5 – You Have Completed Upgrading the MyAssistant Server ....................................................... 16  
Step 6 – Start the MyAssistant Configuration Manager ......................................................................... 17  
**Chapter 4 – MyAssistant Server Configuration** ............................................................................... 18  
Read this section carefully: ..................................................................................................................... 18  
Step 1 – Welcome .................................................................................................................................. 19  
Step 2 – Product Activation .................................................................................................................... 20  
Step 3 – Database Connection ............................................................................................................... 21  
Step 4 – Upgrade the MyAssistant Database ......................................................................................... 22  
Step 5 – Sage 300 CRE Data Folders .................................................................................................... 23  
Step 6 – Notification E-Mail Account ................................................................................................... 24  
Step 7 – Server Options ......................................................................................................................... 25  
Upgrading the MyAssistant Drive Mapper ............................................................................................ 27  
How do I know if I am using the Drive Mapper? ..................................................................................... 27  

**Chapter 5 – Upgrading the MyAssistant Workstation(s)** ..................................................................... 28  
Step 1 – Welcome .................................................................................................................................. 29  
Step 2 – MyAssistant License Agreement ............................................................................................. 30  
Step 3 – Prerequisites for MyAssistant Workstation ........................................................................... 31  
Step 4 – Install the Software .................................................................................................................. 31  
Step 5 – You have Completed Installing MyAssistant ........................................................................ 32
Conventions Used in this Document

This document uses the following conventions:

- The names of screens, windows, fields, and other features displayed by the software are shown in **bold type**.
- Information you enter into the software is in bold type, as in the following example: Enter **Miscellaneous** in the **Amount Type** box.
- Names of keys are shown in capitals; for example, ENTER, TAB. A plus sign (+) between two key names indicates that you should press both keys at the same time; for example, **SHIFT + TAB**.
- The names of buttons you can click with your mouse are enclosed in bold type; for example, [OK] and [Post].

**TIP:** Helpful information to make your experience better.

**NOTE:** This symbol draws your attention to information of particular interest, such as information not included in steps.

**CAUTION:** This symbol draws your attention to information that is important because it can help you avoid a costly or time-consuming error.

**IMPORTANT:** This symbol draws your attention to information that is of critical importance.

This version of the software has been retired.
MyAssistant Upgrade Guide

This document steps you through the upgrade and configuration of the Sage 300 CRE MyAssistant software. If you are installing the MyAssistant software for the first time please refer to the MyAssistant Installation Guide included with the MyAssistant installation files.

Upgrading the MyAssistant software consists of the following steps:

1. Upgrade the MyAssistant Server software.
2. Reactivate the MyAssistant Server software by stepping through the MyAssistant Server Configuration Wizard.
3. (Optional) Upgrade the MyAssistant Drive Mapper.
4. Upgrade the MyAssistant software on the workstation computers or Terminal/Citrix Servers where MyAssistant is used.
5. Depending on a number of settings, you may be asked to reactivate the software on the workstation(s) on first use.

Upgrading and configuring the MyAssistant server should take approximately 30 minutes. Upgrading each MyAssistant workstation should take approximately 10 minutes.

**CAUTION:** It is important that the MyAssistant software is upgraded via a supported upgrade path. The following chart outlines the supported upgrade paths based on the version of the MyAssistant software you are currently running.

To determine what version of the MyAssistant software you are currently running, open the software and select **File > Help > [About]**. The window that opens will show you the version of the software.

Review the table below for the supported MyAssistant upgrade paths:

<table>
<thead>
<tr>
<th>Current MyAssistant Version</th>
<th>MyAssistant Upgrade Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>4.0 and higher</td>
<td>Upgrade directly to MyAssistant 15.1</td>
</tr>
<tr>
<td>3.x or earlier</td>
<td>Upgrade to MyAssistant 4.2, then upgrade to MyAssistant 15.1</td>
</tr>
</tbody>
</table>

If you upgrade from an unsupported path you risk corrupting your MyAssistant data.

This version of the software has been retired.
Support and Training

Telephone Support

When you would like to speak to a customer support analyst directly, call us at 800-551-8307. Telephone support is available Monday through Friday from 6 a.m. to 5 p.m. Pacific Time with the following exceptions:

- Every Thursday from 2 p.m. to 3 p.m. Pacific time (closed for customer support staff meetings)
- Standard United States holidays
- Quarterly company meetings

Sage Customer Portal

You may log on to the Sage Customer Portal at:

The portal provides access to the following services:

- Knowledgebase: Find answers to your questions, access downloads, and subscribe to your articles. This service is available online 24/7.
- Live Chat: Chat online with a customer support analyst; a great option for quick questions. Chat hours are Monday through Friday from 6 a.m. to 3 p.m. Pacific Time, with the same exceptions as telephone support.
- Online Support Request: If you have a question or an issue that is urgent, you can submit an online support ticket. A support analyst will contact you during regular telephone support hours.

Training

Sage University

Sage University offers both recorded and live training sessions. Visit SageU.com for currently available and upcoming classes.

How to access MyAssistant training options in Sage University:
2. Click [Customer Training] and select your Sage 300 Product from the list.
3. In the page that opens, click [Product Training] on the left side of the screen.
4. Click [MyAssistant] in the list that opened.
5. Select either [Realtime Learning] or [Replay Learning] and review the available options in each.

How to access Complimentary MyAssistant Training in Sage University:
2. Click [Customer Training] and select your Sage 300 Product from the list.
3. Click [Complimentary Training] on the left side of the screen.
4. Review the list of complimentary classes for a MyAssistant option.

MyAssistant YouTube Channel

The MyAssistant YouTube channel offers a variety of MyAssistant training videos. Subscribe to the MyAssistant YouTube channel to be notified when new videos are added.

How to access the MyAssistant YouTube channel:
1. Enter www.YouTube.com/MyAssistantTraining
2. The channel will open with all available videos listed.
3. Click on a video to watch.

This version of the software has been retired.
Local Business Partner
Contact your local Business Partner to learn what types of MyAssistant training they can provide.

Before You Begin

- Create a backup of your MyAssistant database prior to upgrading the software.
- Determine the computer where the MyAssistant server software is currently installed. It is most likely on your Sage 300 CRE server.
- Ensure the latest Microsoft Windows and Microsoft Office updates have been installed. Installing the High Priority updates is recommended.
- Gather your MyAssistant Product Keys and Customer Number.

**TIP:** Restart the MyAssistant server prior to performing the upgrade. This will complete any Windows or other software updates where a restart is required.
Chapter 1 – Back Up the MyAssistant Database

Before upgrading your MyAssistant software, it is important that you backup your current MyAssistant database.

1. Log on to the server where the MyAssistant Server software is installed using a Windows user that has administrative privileges.

2. Open the MyAssistant Configuration Manager using the icon on your Desktop (pictured left), or by navigating to Start > All Programs > Sage > MyAssistant > MyAssistant Configuration Manager

3. Navigate to the tab labeled MyAssistant Database Connection

4. Click [Backup Database...] (highlighted below)
5. Specify the location for where the database backup will be stored by accepting the default location or using the [...] button to select a location.

6. After selecting the backup file location, click [Backup MyAssistant Database]

7. When the process has completed, a message will appear that states the backup was successful.

8. After finishing, click [OK].

Now that your MyAssistant database has successfully been backed up, continue with the upgrade of your MyAssistant software.
Chapter 2 – Upgrading the MyAssistant Server

Perform the following to initiate the MyAssistant Server upgrade:

1. Log on to your Sage 300 MyAssistant server with a Windows user that has Administrator or Unlimited permissions.

2. Confirm that you have closed all applications and disabled any anti-virus or Firewall software that may be running.

3. Using the link provided by Sage Software, download the MyAssistant installation files and save the .ZIP file to a folder. Consider saving the .ZIP file to a shared folder so it is accessible from any workstations where MyAssistant will be installed.

   Perform the following to initiate the MyAssistant Server Upgrade:
   
   a) Open the location of the downloaded MyAssistant Installation files.
   
   b) Unzip the files to a folder on the local drive on the MyAssistant Server.
   
   c) Open the location of the unzipped MyAssistant installation files and double click autorun.hta

4. The Sage 300 CRE MyAssistant Installation hub will open.

   Click [Install Server] to start the MyAssistant Server upgrade.
Step 1 – MyAssistant Server Upgrade

The MyAssistant Installation wizard starts once you have selected the type of install.

Click [Next] to continue.

This version of the software has been retired
Step 2 – MyAssistant License Agreement

You must accept the Innovative Software Design License Agreement to upgrade the Sage 300 CRE MyAssistant software. A complete copy of the License Agreement is provided with the MyAssistant installation files.

If you agree to the terms of the License Agreement, check the I accept the terms in the license agreement checkbox and click [Next] to continue.
Step 4 – MyAssistant Server Prerequisites (Optional)

This window displays the any prerequisite software that needs to be upgraded.

This version of the software has been retired

**IMPORTANT.** It is highly unlikely that you will encounter this screen when upgrading MyAssistant – the most likely scenario for seeing this screen would be if you are using a full version of the Microsoft SQL Server.

*Only* check the “Do not install SQL Server Express” box if you have separately purchased, installed and will be using a full version of the Microsoft SQL Server database engine. The MS SQL Server edition (i.e. Full or Express) is not displayed in the list of installed programs in Windows. Do not check this box if you are unsure whether you have a full version of Microsoft SQL Server installed. By checking this box you are taking full responsibility for the installation, setup, and maintenance of the SQL Server instance that MyAssistant will use.
Step 4 – MyAssistant Software

Determine where the MyAssistant program files will be installed on your server.

Accept the default location or use the [Browse] button to specify a different location.

Click [Next] to begin the installation of the updated MyAssistant software.
Step 5 – You Have Completed Upgrading the MyAssistant Server

Congratulations, you have completed upgrading the MyAssistant Server.

Click [Finish] to close the wizard and have the option to continue to the Configuration Manager.

**NOTE:** You must step through the Configuration Manager on the server before upgrading MyAssistant on any Workstations.

This version of the software has been retired.
Step 6 – Start the MyAssistant Configuration Manager

After clicking Finish, you will be prompted to start the MyAssistant Configuration Manager.

Click [Yes]. Continue to Chapter 4 to walk through reactivating the MyAssistant Server.

Note: You must step through the Configuration Manager on the server before upgrading MyAssistant on any Workstations.
Chapter 4 – MyAssistant Server Configuration

This chapter walks through reactivating the MyAssistant Server software. When in the configuration manager, you can verify that all settings are still accurate. Configuring the server must be completed before upgrading MyAssistant on any workstations.

Read this section carefully:

You will complete the following steps to configure the MyAssistant Server:

1. Reactivate the software.
2. Upgrade your MyAssistant database.
3. Confirm the prefilled file paths for Sage 300 CRE data folders
4. Confirm the prefilled Mail Server settings for sending emails are correct
5. Review and modify the MyAssistant Server settings as needed

NOTE: Reactivating the software and stepping through the Configuration Manager on the MyAssistant Server will take approximately 10 minutes.
Step 1 – Welcome

If the MyAssistant Configuration wizard isn’t started, open it with the desktop icon or by following this path: Windows Start > All Programs > MyAssistant > MyAssistant Configuration Manager.

Only check Show Advanced Options if you:
- Are using a Web Proxy Server.
- Are using a full version of the Microsoft SQL Server database.
- Would like to define the Microsoft SQL Server credentials that will be used to access MyAssistant data.

If established in a prior version of MyAssistant, the information for the items above will already be entered.

This version of the software has been retired.
Step 2 – Product Activation

The MyAssistant Server must be reactivated. The Product Key and Customer Number may be prefilled.

If you use a Web Proxy Server, check the box displayed under the Server Product Key field and verify that the information entered is accurate.

NOTE: The Web Proxy Server checkbox will only appear if you selected Show Advanced Options in the Welcome Screen (Step 1).

If you use a Web Proxy Server, check the box displayed under the Server Product Key field and verify that the information entered is accurate.

This version of the software has been retired.
Step 3 – Database Connection

**NOTE:** This step will only be available if you click [Show Advanced Options] in the Welcome step.

![Database Connection Wizard](image)

**CAUTION:** Making changes in this step can break the connection to the MyAssistant database. Modifying these fields requires advanced knowledge of SQL Server database engines. It is highly recommended that you do not make any changes in this step when upgrading your MyAssistant Server.

This step gives you access to the server name, SQL Server credentials, and SQL Instance and Port Number MyAssistant uses to connect to the Database.

This step will have all previously entered information prefilled.

Click [Next] to continue.
Step 4 – Upgrade the MyAssistant Database

MyAssistant will perform the necessary steps to upgrade your database.

Click [Next] to upgrade the database.

This version of the software has been retired.
Step 5 – Sage 300 CRE Data Folders

Verify that the information in this step is still accurate. These are the data folders MyAssistant will be able to monitor, and the Sage 300 CRE credentials MyAssistant will use to access the data.

Click [Next] to continue. If there is more than one data folder entered, you will be prompted to select which folder you wish to have Database Customizations imported from. If there is only one data folder specified, Database Customizations will be imported automatically.

If the Sage 300 CRE password entered in this step is set to expire, a warning message will pop up. When the password does expire, you will need to reopen the MyAssistant Configuration Manager and enter the new credentials in this step. Updating the settings for this User account in Sage so the password never expires is recommended.
**Step 6 – Notification E-Mail Account**

Verify your mail server settings are still accurate. Notification emails will originate from the name and email address specified in this step.

The mail server settings will show what was entered the last time the software was configured. If nothing has changed, click [Next].

This version of the software has been retired.
Step 7 – Server Options
This final step is used to determine a variety of settings around the MyAssistant Server.

**Daily Summaries:** MyAssistant Daily Summary email messages are used to send each recipient their notifications across several Tasks in one email message. See the MyAssistant User Guide for more information. This time should be after all of your daily Tasks have run.

**Send Errors To:** Someone to be notified when MyAssistant encounters an error. It is recommended to send error messages to the primary MyAssistant user.

**Save MyCommunicator Email Messages:** Sage MyCommunicator for Outlook allows you to centrally track users’ email correspondence related to your business. In addition to creating a record of business-related emails, a copy of the mail messages can be saved and linked to your Sage data (e.g. Jobs, vendors, customers, etc). To enable this function, check the box in this section and click [Browse...] to select a folder location.

**Running Tasks and Sending Service Settings:** MyAssistant runs Tasks, sends emails and updates Sage data with MyCommunicator via background processes (i.e. Windows Services) on the server. These processes are now scalable to increase performance, and auto-correct in the event of a hang.
These MyAssistant Services (named ISDAdminTaskService and ISDAdminSenderService) start other processes named "TaskRunner"32," which each take 30-50Mb of memory when idle. Many variables affect the system resources used when Tasks run and emails are sent, including:

- The available server memory
- Disk drive performance
- Other server demands at the time the MyAssistant Tasks are run. For example, running Tasks at night may allow additional server resources to be dedicated to MyAssistant.

Perform the following to determine the optimal number of processes:

- Complete the MyAssistant server configuration with the default settings and the MyAssistant workstation installation.
- Activate two MyAssistant Tasks you will regularly use.
- Use the Windows Task Manager and the Resource Monitor to track server memory usage and disk queue lengths when both Tasks are run concurrently.
- Open the MyAssistant Configuration Manager and increase or decrease the number of processes based on available server resources.

Click [Finish] to close the MyAssistant Server Configuration Wizard.

Once the Configuration Wizard is closed, the Server portion of the MyAssistant installation is complete. Continue to Chapter 5 to install the MyAssistant Workstation.
Upgrading the MyAssistant Drive Mapper

If you use a Mapped Drive (i.e., drive letter “T:”) to access your Sage 300 CRE data or programs files, you need to upgrade the MyAssistant Drive Mapper. The MyAssistant Drive Mapper is used by the Windows Service that runs MyAssistant Tasks, to access your Sage 300 CRE database or programs.

How do I know if I am using the Drive Mapper?
Perform the following to determine if you are using the MyAssistant Drive Mapper.

1. Log on to the server where the MyAssistant server is installed
2. Open Windows Explorer
3. Go to the folder where the MyAssistant program files are installed. If you accepted the default location when installing the software, the MyAssistant program files will be in the following location:
   C:\Program Files (x86)\Innovative Software Design\MyAssistant.
4. Look for a file named InnovativeSoftwareDesign.MyAssistant.DriveMapperCommand.dll in the MyAssistant, Task Service, or Sender Service folders

If this file exists, you are using the MyAssistant Drive mapper and it will need to be updated in all three locations (the MyAssistant, Task Service and Sender Service program folders).

CAUTION: The MyAssistant Drive Mapper must be used if you are using mapped drives to access your Sage 300 data files or Program Files. If you are using UNC paths and do not use any mapped drives, you do not need to use the Drive Mapper tool.

Perform the following to upgrade the MyAssistant Drive Mapper:

1. Log on to the computer where the MyAssistant server is installed using a Windows user that has Administrator or Unlimited privileges.
2. Open the folder containing the MyAssistant installation files. This will be a location you selected when saving the files. There is no default location.
3. Using Windows Explorer, copy and replace the file InnovativeSoftwareDesign.MyAssistant.DriveMapperCommand.dll from the Tools > DriveMapperCommand folder in the MyAssistant installation files to the folder where the MyAssistant software has been installed. If you accepted the default location when installing the MyAssistant software, this location will be C:\Program Files\Innovative Software Design\MyAssistant.
4. The InnovativeSoftwareDesign.MyAssistant.DriveMapperCommand.dll also needs to be placed in the following locations:
   a. Program Files\Innovative Software Design\MyAssistant\Sender Service
   b. Program Files\Innovative Software Design\MyAssistant\Task Service
5. Once you have replaced this file, restart the ISDAdminTaskService and ISDAdminSenderService from the Windows Services window. Follow the instructions below to do this.
   1. Click to open the Start menu and click [Run]
   2. In the Run box type services.msc to open the Windows Services window
   3. Look down the list for ISDAdminTaskService and ISDAdminSenderService
   4. Restart both of these services.

The MyAssistant Drive Mapper tool is now upgraded.
Perform the following to initiate the MyAssistant Workstation upgrade.

1. Log on to your Sage 300 MyAssistant workstation with a Windows user that has Administrator or Unlimited permissions.

2. Confirm that you have closed all applications and disabled any anti-virus or Firewall software that may be running.

3. Using the link provided by Sage Software, download the MyAssistant installation files and save the .ZIP file to a folder on your machine. If accessible from the workstation, you can use the same files that were used to upgrade the MyAssistant Server. Perform the following to initiate the MyAssistant Workstation Upgrade.
   a) Open the location of the downloaded MyAssistant Installation files.
   b) Unzip the files to a folder on the local drive on the MyAssistant Server.
   c) Open the location of the unzipped MyAssistant installation files and double click autorun.hta

4. The Sage 300 CRE MyAssistant Installation hub will open.

   **Install Workstation** – Select [Install Workstation] to perform a MyAssistant workstation upgrade.
Step 1 – Welcome

When you select Workstation Install on the MyAssistant splash screen, the Setup Workstation wizard will appear.

Click [Next] to continue.

This version of the software has been retired.
Step 2 – MyAssistant License Agreement

Read and accept the Innovative Software Design End-User License Agreement. You must accept the Innovative Software Design License Agreement to use the Sage 300 CRE MyAssistant software.

Click [Next] to continue.

This version of the software has been retired.
Step 3 – Prerequisites for MyAssistant Workstation

The next window displays the prerequisite software that MyAssistant may need to upgrade. If there are no software updates necessary on the workstation, the Setup Workstation Wizard will skip this step. Once all prerequisites have been installed, click [Next] to continue with the MyAssistant Workstation Install.

Step 4 – Install the Software

Click [Next] to begin the installation of updated MyAssistant software on the workstation.

This version of the software has been retired.
Step 5 – You have Completed Installing MyAssistant

Congratulations. MyAssistant has successfully been upgraded on this machine.

Click [Finish] to close the setup wizard.
Chapter 6 – MyAssistant Workstation Configuration

NOTE: Depending on a number of settings, you may not need to reactivate the Workstation. If this is the case, MyAssistant will open ready to use.

Step 1 – Welcome Screen

Double click on the MyAssistant icon on the desktop to open the MyAssistant software.

If there is not a shortcut on the desktop, follow the path below to open MyAssistant:

Open the Windows Start Menu > All Programs > MyAssistant (File) > MyAssistant
Step 2 – Product Activation

You must activate MyAssistant in order to use it. A working internet connection is required to complete this step. Your customer number and product key may already be entered. Reactivate before clicking next.

NOTE: The Web Proxy Server connection fields will only be available if you clicked [Show Advanced Options] in the Welcome step. Verify the information and click [Next].
**Step 3 – Entering Sage 300 CRE Data Folder Information**

The information in this step will be prefilled. Verify that it is accurate.

Click [Next] if all information is correct.

This version of the software has been retired.
Step 4 – User Profile

This step shows the personal information for the Windows user on this workstation.

![MyAssistant User Configuration Wizard]

Sage 300 CRE MyAssistant will start upon clicking Finish in the wizard.

This version of the software has been retired.
Chapter 7 – Upgrading a Terminal Server

CAUTION: This chapter is written for clients who will be running the MyAssistant Server and at least one MyAssistant User on a Terminal or Citrix Server.

What is Involved
Here is a list of what needs to be done to upgrade MyAssistant on a Terminal or Citrix Server:

1. Log onto the Server as a System Administrator.
2. Run the MyAssistant Server installation to upgrade.
3. Activate MyAssistant with a Server Product Key.
4. Log onto the machine with a Windows user who will run the software.
5. Open the MyAssistant user Application.
6. Depending on a number of settings, the user may need to reactivate the software.

Before Upgrading
Before MyAssistant can be upgraded on any accounts other than the administrator, permissions must be given to specific files. Find a list below of these files. The default paths have been provided for your convenience below, however they may vary slightly.

If on Windows 2008:
- C:\Program Data
- C:\Program Files\Innovative Software Design
  OR
- C:\Program Files(x86)\Innovative Software Design

If on Windows 2012:
- C:\Program Data
- C:\Program Files\Innovative Software Design
  OR
- C:\Program Files(x86)\Innovative Software Design

IMPORTANT: Permissions need to be given to these folders prior to activating any MyAssistant users on this machine.

Upgrading the MyAssistant Server
Complete to Chapters 1 through 4 for upgrading the MyAssistant Server. When you have completed Chapter 4, return to this Chapter to activate the MyAssistant User Software on this Terminal or Citrix Server.

Activating the MyAssistant Workstation
Once the MyAssistant Server is upgraded and configured, log onto the Terminal or Citrix Server as the Windows user who will be using the MyAssistant software.

- If there is a MyAssistant icon on the desktop, double click to open the User Configuration Manager.
- If there is not an icon on the desktop follow this path:
  Start > All Programs > Sage > MyAssistant (folder) > MyAssistant

When the User Configuration Manager is open complete the steps in Chapter 6 to activate the MyAssistant workstation.
Chapter 7 – Test the Upgrade

The last step in the upgrade process is to confirm that MyAssistant is working properly. Perform the following to test this:

Access Sage 300 CRE Data
1. Open the MyAssistant Designer software from a MyAssistant workstation.
2. Open an activated MyAssistant Task.
3. Move to the Email step in the Edit Task window.
4. On the right side of the window is a list of available Sage 300 CRE database records.
5. Expand the very first record.
6. Right click on the first field and select [Browse Data].
7. The data contained in the field should be displayed in the Browse Data window.

Troubleshooting
1. Perform the following if data is not displayed in the Browse window:
   a. Select File > [Options] to open the Options window.
   b. Move to the Sage 300 CRE Data Folder step.
   c. Click [Test Connection] to confirm that the Sage 300 CRE credentials entered are able to access the Sage 300 CRE data. If the test fails, enter updated credentials.
2. Contact support if an error is displayed when browsing data.

Run Tasks and Receive Email Messages
1. Open the MyAssistant software from a MyAssistant workstation.
2. Browse to an activated Task. If possible, select a Task with an attached Crystal Report that is being sent to you (edit the recipient list as needed).
3. Right click on the Task and click [Run and Send].

Troubleshooting
1. If the Task doesn’t finish running:
   a. Log onto the MyAssistant Server.
   b. Open the Windows Services window (Start > Run > type: Services.msc).
   c. Look for the ISDAdminTask and ISDAdminSender services. Confirm both are started.
2. If the Task finishes running but an email is not received:
   a. Open the Windows Services window (Start > Run > type: Services.msc).
   b. Look for the ISDAdminSenderService. Right click on the service and select [Properties].
   c. Click the [Log On] tab.
   d. Select [This account] and enter a Windows user that is associated with a person who is an administrator in the Sage 300 CRE software.
   e. Click [OK] and then restart the Service.
   f. If the report is not attached to the email
      a. Perform the steps outlined for #2 above.
Conclusion
This completes the upgrade of the Sage 300 CRE MyAssistant software. The next step is to learn your way around the updated software. Please refer to the User Guide for information on using MyAssistant.